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NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5.  TERM:  This Agreement is effective upon your using the SOFTWARE and remains in
effect until expiration of all copyright interests in the SOFTWARE unless earlier
terminated.  You may terminate this Agreement by destroying the SOFTWARE.  This
Agreement will also terminate without notice to you if you fail to comply with any of
the terms of this Agreement and you must then promptly return the SOFTWARE.  In
addition, Canon may enforce its other legal rights.

6.  U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE:  The SOFTWARE is provided with
restricted rights.  Use, duplication or disclosure is subject to restrictions as set forth in
either subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software
clause at DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial
Computer Software Restricted Rights Clause at FAR 52.227-19, as applicable.

7.  SEVERABILITY:  In the event that any provision of this Agreement is declared or found
to be illegal by any court or tribunal of competent jurisdiction, such provision shall be
null and void with respect to the jurisdiction of that court or tribunal and all the
remaining provisions of this Agreement shall remain in full force and effect.

8.  CONTROLLING LAW:  The terms of this Agreement as it relates to purchases of the
Software in the United States of America shall be governed and construed in all
respects in accordance with the laws and regulations of the State of New York, without
reference to choice of law principles.  The terms of this Agreement as it relates to
purchases of the Software in Canada shall be governed by the laws of the province of
Ontario.

9.  OWNERSHIP:  All rights, including but not limited to copyrights and trade secret rights,
to the SOFTWARE belong to Canon, its affiliated corporations and third party licensors.
Your use of the SOFTWARE is subject to the United States, Canada and other applicable
copyright and trademark laws and nothing in this Agreement constitutes a waiver of
the rights of Canon, its affiliated corporations and third party licensors under such laws.
Nothing contained in Paragraph 1 shall be construed to give Canon any ownership
rights in any images, graphics or textual material that you save in connection with the
Software.

10.  ACKNOWLEDGEMENT:  BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS.  YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS OR
PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF.  NO AMENDMENT
TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY AUTHORIZED
OFFICER OF CANON.
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Introduction
Thank you for purchasing a Canon digital camera. This guide explains the software used
with the following models.

• PowerShot S100 DIGITAL ELPH
• DIGITAL IXUS
• PowerShot S10
• PowerShot S20

Note
• The serial port interface is only supported by the PowerShot S10 and PowerShot

S20 models.

Disclaimer
• While every effort has been made to ensure that the information contained in this guide is

accurate and complete, no liability can be accepted for any errors or omissions. Canon Inc.
reserves the right to change the specifications of the hardware and software described
herein at any time without prior notice.

• No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language in any form, by any means, without the prior written
permission of Canon Inc.

• Canon Inc. makes no warranties for damages resulting from corrupted or lost data due to
a mistaken operation or malfunction of the camera, the software, the CompactFlash™
cards (CF cards), personal computers, peripheral devices, or use of non-Canon CF cards.

Trademark Acknowledgments
• Canon and PowerShot are trademarks of Canon Inc.
• Adobe, Adobe PhotoDeluxe and Photoshop are trademarks of Adobe Systems Incorporated.
• CompactFlash is a trademark of SanDisk Corporation.
• IBM is a registered trademark of International Business Machines Corporation.
• iBook and iMac are trademarks of Apple Computer, Inc.
• Macintosh, PowerBook, Power Macintosh and QuickTime are trademarks of Apple Computer

Inc., registered in the United States and other countries.
• Microsoft, Windows and Windows NT are either registered trademarks or trademarks of

Microsoft Corporation in the United States and/or other countries.
• Other names and products not mentioned above may be registered trademarks or trademarks

of their respective companies.

Copyright © 2000 Canon Inc. All rights reserved.
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Introducing the Software
This section introduces the powerful software programs for the Windows platform
contained on the CD-ROMs included with the camera.

Canon Digital Camera Solution Disk

ZoomBrowser EX

To load camera images, start ZoomBrowser EX.

Camera Connection Functions
(Also effective for CF card readers or PC card readers)

• Displays camera images.
• Downloads camera images to the computer.
• Saves computer images to a CF card in the camera.
• Edits slide shows for replay by the camera (PowerShot S10/S20 models only).
• Connecting to a USB port automatically starts ZoomBrowser EX and displays the

camera images.

Image File Management Functions
• Displays, moves, copies or deletes images stored on computer disks.
• Allows simple editing procedures, such as image color adjustments and cropping.
• Displays all the files in a specified folder at once and zooms them in and out to

facilitate visual searches.
• Displays files in chronological order in a window that looks like a time tunnel.
• Replays images from the computer one-by-one at full screen size to simulate a

slide show.

Image Printing Functions
• Prints multiple images on the same page using the PhotoRecord printing utility.
• Performs auto layouts.
• Allows you to effortlessly place frames or backgrounds around your images for

artistic effect.
• Allows you to place titles or captions anywhere on the page .
• Lets you create your own exclusive albums.

Supports PhotoStitch Panoramas
• Allows you to select camera images or images registered with ZoomBrowser EX and

start PhotoStitch from within ZoomBrowser EX to merge a series of images into a
panorama in a few simple steps.
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Supports the Adobe PhotoDeluxe Photo Retouching Program
• Starts this photo-retouching program to edit and apply special effects to your

images. Adobe PhotoDeluxe Home Edition can be installed from the Adobe
PhotoDeluxe CD-ROM.

Starts Your E-mail Program
• Starts your e-mail program and prepares images as e-mail attachments.
• Allows you to adjust the image size and quality to reduce file sizes for transmission.

PhotoStitch
• Automatically arranges images shot in Stitch Assist mode into the correct order and

effortlessly merges them.
• Merges any number of images horizontally or vertically, or in a matrix format.
• Makes images with straight lines appear natural not crooked when merged. (Select

the Wide display format.)
• A 360-degree scene shot in several frames can be merged into a 360-degree image

and saved in the QuickTime VR format, making it appear as if you were standing in
the middle of the image looking about in all directions.

TWAIN Drivers
Canon Digital Camera USB TWAIN Driver
Canon Digital Camera RS-232C TWAIN Driver

These are the driver utility programs that work within TWAIN-compliant application
programs, such as Adobe PhotoDeluxe Home Edition and Photoshop, to load camera
images directly into the application program. The USB TWAIN Driver is for use when
the camera is connected via the USB interface. The RS-232C TWAIN Driver is for use
when the camera is connected via a serial (COM) port. Neither TWAIN driver can be
used as a stand-alone software program.

Adobe PhotoDeluxe CD-ROM

Adobe PhotoDeluxe Home Edition
• Allows you to edit images and effortlessly create greeting cards, birthday cards and

calendars.
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System Requirements
The following system requirements must be met to install and operate the software.

=Computer Model
IBM PC/AT compatible

=OS
Windows 95, Windows 98 (Including the Second Edition),
Windows NT 4.0 (Service Pack 3 or higher required) or
Windows 2000

=CPU
Pentium 133 MHz or better

=RAM
32 MB or more (Windows 95/98)
64 MB or more (Windows NT 4.0/Windows 2000)

= Interface
USB (Limited to pre-installed Windows 98 or

Windows 2000 systems)
RS-232C (Serial/COM port for PowerShot S10/S20

models only)

=Free Hard Disk Space
Canon Utilities
     ZoomBrowser EX: 120 MB or more

     (Including the PhotoRecord printing utility)
     PhotoStitch: 40 MB or more
Canon Digital Camera USB TWAIN Driver: 15 MB or more
Canon Digital Camera RS-232C TWAIN Driver:

15 MB or more
Adobe PhotoDeluxe Home Edition: 140 MB or more

   (Works with the Windows 95/98/NT 4.0 operating systems)

=Display
Minimum: 800 x 600 pixels, 256 colors
Recommended: 1,024 x 768 pixels, High Color (16 bit) or

more

• A CD-ROM drive is required to install the software.
• QuickTime 3.0 or higher is required to save PhotoStitch output in the QuickTime VR

format.
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Installing/Uninstalling the Software
Installing from the Canon Digital Camera Solution Disk

If you are installing the software onto Windows NT 4.0 or Windows 2000, you must
first log on as the administrator and then install the software.

1. Close any programs that are running.

2. Place the Canon Digital Camera Solution Disk in the CD-ROM drive.
The installer panel will automatically display.

• If the installer panel does not automatically display, use the following procedures
to start it.
1. Double-click the [My Computer] icon on the desktop, and double-click the

CD-ROM icon in the next window.
2. Double-click the [Setup] icon.

3. Click [Software Installation].

4. Select the install location and click the [Next] button.

5. Select the software you wish to install and follow the on-screen
instructions to proceed.

6. Click the [Finish] button when the installation is complete and the
installer panel appears again.
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Installing from the Adobe PhotoDeluxe CD-ROM
For installation instructions, place the Adobe PhotoDeluxe CD-ROM in the drive and click
[ReadMe & Guide] and [Install Guide] in the window that displays.

The serial number shown during installation will be required for the user
registration process.

If You Will Be Connecting via a USB Port
You must install a separate USB driver. Please see page 13 for instructions.

Uninstalling the Software
To remove the installed software, click the Windows [Start] menu and select [Settings],
[Control Panel] and [Add/Remove Programs]. ZoomBrowser EX can also be uninstalled by
clicking the [Start] menu and selecting [Programs], [Canon Utilities], [ZoomBrowser EX],
and [Uninstall ZoomBrowser EX]. (PhotoRecord and PhotoStitch can be removed with the
same procedures.)
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Connecting the Camera to a Computer
Selecting a Connection Method
The following different interfaces and methods can be used to connect the camera to a
computer. Once a connection has been established using one of the methods, you can
start the software and begin to load the camera images (➜ p. 21 or 41).

Use the AC Adapter
• You are recommended to use the AC adapter while the camera is connected to a

computer to conserve the battery charge.

USB Port (➜ p. 11)

The USB interface transfers data more rapidly than the serial interface and can start
the image loading software automatically.

CF Card Reader or PC Card Slot  (➜ p. 19)

If you have a computer equipped with a PC card slot, a CF card reader or a PC card
reader, you can place the camera’s CF card into these devices to establish a direct
connection. You will require a PC card adapter for PC card slots.

CF Card

USB Cable Connector Shapes

Computer EndCamera End

Computer USB Port

The USB port is
marked with
this symbol.
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Serial Port (COM Port) (➜ p. 20)

The serial interface is supported by the PowerShot S10 and PowerShot S20 models only.

Serial Cable Connector Shapes

Camera End Computer End

Computer Serial Port

The serial port
is marked with
this symbol.
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Connecting to a USB Port

Requirements for the USB Interface
• The USB interface can only be used to connect the camera to computers with

Windows 98 or Windows 2000 preinstalled (clean installation). The USB ports on
computers running versions of Windows 98 or Windows 2000 upgraded from
Windows 3.1 or Windows 95, or versions of Windows 2000 upgraded from
Windows 98 may not operate correctly.

• Connect the USB cable directly to one of the computer’s main USB ports. The
interface may not function correctly if the camera is connected via a USB hub.

• The interface may not function correctly while other USB devices, excluding USB
mice and keyboards, are connected. If this problem arises, detach the camera
and the other devices, and reconnect the camera only.

• Do not attach more than one camera to the USB ports of the same computer at
the same time. The cameras may not operate correctly.

Important
• Please do not place your computer into standby mode while the camera is

connected to its USB port. If you place the computer into standby mode while
the camera is connected to a USB port, do NOT disconnect the USB cable from
the camera or computer. Try to revive the computer. If the USB cable is detached
in standby mode, some computers may not return to active mode correctly. For
instructions regarding the standby mode, please consult the manual
accompanying your computer and operating software.
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1. Attach the supplied USB cable to a USB port directly on the computer
and to the DIGITAL terminal on the camera as shown below.
• There is no need to turn the camera or computer power off when attaching or

detaching the USB cables.
• Please consult your computer’s manual for the location of the USB ports.

2. Install the USB driver the first time you connect via a USB port. (➜ p. 13)

Precaution for Unplugging Cables
from the DIGITAL Terminal
• Always press the [PUSH] button on the

connector to detach the cable from the
camera’s DIGITAL terminal.

USB Port

DIGITAL Terminal
1. Open the DIGITAL terminal cover

by slipping a fingernail under the
top edge and pulling down.

USB Connector

USB Connector

2. Insert the connector so that the4 marks on
the connector and camera align.

PUSH Button
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Installing the USB Driver
(Preinstalled Windows 98/2000 Systems Only)

Notes Regarding Installation
• The USB driver only needs to be installed the first time the camera is connected via the

USB interface. Installation is not required from the second time onward.
• Do not cancel the installation partway through. Allow the procedure to finish completely

before exiting. The camera may not operate correctly if the installation is incomplete.
• Read the Troubleshooting the Driver Software Installation section on page 44 if the

installation cancels itself during the procedure, if the installation does not proceed as
described in these procedures, or if you think that the drivers are not properly installed.

• Read the “Uninstalling the USB Driver” section on page 44 for instructions for that
procedure.

Installing the USB Driver into Windows 98

Windows 98 CD-ROM
• Your computer may prompt you to insert the CD-ROM containing your Windows

system software during the installation. Have the Windows disk handy in case it is
required.

1. Once you have attached the USB cable to the camera and computer, set
the camera to the mode for communicating with a computer. (➜ p. 12)
• PowerShot S100 DIGITAL ELPH/DIGITAL IXUS

Slide the mode switch to the  position and press the main switch to turn on
the power.

• PowerShot S10/S20
Turn the mode dial to the  position.

The “Add New Hardware Wizard” dialog will appear after a moment.

2. Read the dialog and click the [Next] button.

The dialog will change to the search selection dialog.

Your camera model name
will appear here.
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3. Select [Search for the best driver for your device (recommended)] and
click the [Next] button.

The dialog will change to the one that allows you to specify the search location.

4. Place the Canon Digital Camera Solution Disk in the CD-ROM drive.

5. Confirm that the [CD-ROM drive] option is selected in the dialog and
click the [Next] button.

The dialog will change to the one that states it is searching for the driver files.

6. Read the dialog and click the [Next] button.

Your camera model name
will appear here.
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The computer will start to copy the driver files from the CD-ROM.

When all the required files have been copied, the dialog will state that the
installation is complete.

What to Do if You Are Prompted for the Windows System Disk
during the Driver File Copying Process
• If prompted for the Windows system disk, replace the Canon Digital Camera

Solution Disk with it and follow the on-screen instructions. If a dialog states that
the “usbscan.sys” cannot be found, click the [Browse] button and specify the
location as the [WIN98] folder on the Windows system disk.

7. Read the dialog and click the [Finish] button.

An event dialog for your camera model will display to allow you to select
application programs. (➜ p. 21, Step 2, or p. 41, Step 2.)
• If a dialog prompts you to restart your computer, remove the CD-ROM from the

drive and restart the computer as instructed.

Do NOT cancel the copy
operation while it is in progress.

Your camera model name
will appear here.
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Installing the USB Driver into Windows 2000

Begin by logging onto the computer as the Administrator and then install the USB
driver.

1. Once you have attached the USB cable to the camera and computer, set
the camera to the mode for communicating with a computer. (➜ p. 12)
• PowerShot S100 DIGITAL ELPH/DIGITAL IXUS

Slide the mode switch to the  position and press the main switch to turn on
the power.

• PowerShot S10/S20
Turn the mode dial to the  position.

The “Add New Hardware Wizard” dialog will appear after a moment.

2. Read the dialog and click the [Next] button.

3. Select [Search for a suitable driver for my device (recommended)] and
click the [Next] button.

The dialog will change to the one that allows you to specify the search location.

4. Place the Canon Digital Camera Solution Disk in the CD-ROM drive.

Your camera model
name will appear
here.
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5. Confirm that the [CD-ROM drives] option is selected in the dialog and
click the [Next] button.

The dialog will change to the one that states it is searching for the driver files.

6. Read the dialog and click the [Next] button.

7. Click the [Yes] button if the “Digital Signature Not Found” message
displays.

Your camera model
name will appear
here.

Your camera model
name will appear
here.

Your camera model
name will appear
here.
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8. Click [No to All] if the “Confirm File Replace” dialog displays.

9. Read the dialog and click the [Finish] button.

An event dialog for your camera model will display to allow you to select
application programs. (➜ p. 21, Step 2 or p. 41, Step 2.)
• If a dialog prompts you to restart your computer, remove the CD-ROM from the

drive and restart the computer as instructed.

Your camera model
name will appear
here.
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Connecting via a CF Card Reader or PC Card Slot
To load images directly from a CF card to a computer, eject the card from the camera,
place it in a separately sold PC card adapter (PCMCIA card adapter) and insert the
assembly into the PC card slot.

The adapter is not required if your computer is equipped with a CF card reader. Place the
CF card directly into the reader.

1. Place the CF card in the PC card adapter.

2. Insert the loaded PC card adapter into the computer’s slot or PC card
reader.
The requirements for the power being on or off when the PC card adapter is
inserted differ according to the product. Please consult the manuals accompanying
your equipment.

Insert the Adapter in the Slot.

Place the CF Card in the Adapter.
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Connecting to a Serial Port (COM Port)
The serial port interface is only supported by the PowerShot S10 and PowerShot S20
models.

1. Shut down the computer and turn the camera power off.

2. Attach the supplied serial cable to a serial port on the computer and to
the camera’s DIGITAL terminal as shown below.
• Please consult your computer’s manual for the location of the serial port.

3. Turn on the computer and start Windows.

PUSH Button

Precaution for Unplugging Cables
from the DIGITAL Terminal
• Always press the [PUSH] button on the

connector to detach the cable from the
camera’s DIGITAL terminal.

Serial Port (COM Port)

DIGITAL Terminal
1. Open the DIGITAL terminal cover

by slipping a fingernail under the
top edge and pulling down.

Serial Connector

Serial Connector

2. Insert the connector so that the4 marks on
the connector and camera align.
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From Loading to Printing
This section provides a simple explanation of the procedures for using ZoomBrowser EX
to load and print images. Please refer to the ZoomBrowser EX Help file for more details.

What to Do if the “Caution! Connection Time” Dialog Displays
• If approximately five minutes pass without a camera function being accessed when

the camera is connected via the USB interface, a message on the computer display
will ask if you wish to remain connected. If you do not access a function, the
camera will close the connection after an additional minute passes. Use the
procedure below to reconnect.
• PowerShot S100 DIGITAL ELPH/DIGITAL IXUS

Press the camera’s main switch.
• PowerShot S10/S20

Press the camera’s shutter button. (The dialog will not appear and the camera
will not close the connection if the camera is being powered by the AC adapter.)

Starting ZoomBrowser EX
USB Interface

1. Attach the camera to the computer with the USB cable. (➜ p. 12)

2. Set the camera to the mode for communicating with a computer.
• PowerShot S100 DIGITAL ELPH/DIGITAL IXUS

Slide the mode switch to the  position and press the main switch to turn on
the power.

• PowerShot S10/S20
Turn the mode dial to the  position.

An application selection dialog will display.

3. Select [Canon ZoomBrowser EX] and click the [OK] button.
ZoomBrowser EX will start and display the camera’s images as small thumbnail
images in the ZoomBrowser EX Camera Window. (➜ p. 24)

Your camera model name
will appear here.
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How to Have ZoomBrowser EX Start Automatically
• If you want ZoomBrowser EX to start automatically without first displaying the event

dialog, use the procedures below to change the settings.
1. Open the [My Computer] window while the camera is connected to the

computer via the USB interface.
2. Open the [Control Panel] and select [Scanners and Cameras] and your camera

model.
3. Click the [Properties] button and display the [Events] tab.
4. A list of applications registered for automatic starting will display. Remove the

checks beside every program except for ZoomBrowser EX. Click the [OK] button.
• ZoomBrowser EX will now start automatically the next time you connect the camera.

If the [Disable device events] option has a check mark, the automatic start will be
turned off.

CF Card Reader or PC Card Slot Interface

1. Place the CF card into the CF card reader or into the PC card adapter and
then into the PC card slot. (➜ p. 19)

2. Start ZoomBrowser EX.
Double-click the [Canon ZoomBrowser EX] icon on the desktop to start the program.

If the [Canon ZoomBrowser EX] icon does not appear on the desktop, click the
Windows [Start] button and select [Programs], [Canon Utilities], [ZoomBrowser EX]
and [ZoomBrowser EX].

Quick Tips will automatically display. Read these tips to quickly understand
operating procedures.

3. Click the [IMPORT IMAGES] button and select [From Dcim].
The images from the CF card will display in ZoomBrowser EX Camera Window as
small thumbnail images. (➜ p. 24)

Canon ZoomBrowser EX Icon
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Serial Interface

1. Attach the camera to the computer with the serial cable. (➜ p. 20)

2. Turn the camera’s mode dial to the  position.

3. Start ZoomBrowser EX.
Double-click the [Canon ZoomBrowser EX] icon on the desktop to start the program.

If the [Canon ZoomBrowser EX] icon does not appear on the desktop, click the
Windows [Start] button and select [Programs], [Canon Utilities], [ZoomBrowser EX]
and [ZoomBrowser EX].

Quick Tips will automatically display. Read these tips to quickly
understand operating procedures.

4. Click the [IMPORT IMAGES] button and select [From Camera].
The camera’s images will display as small thumbnail images in the ZoomBrowser EX
Camera Window. (➜ p. 24)

Canon ZoomBrowser EX Icon
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The ZoomBrowser EX Camera Window
The Camera Window will open when a connection to a camera or CF card is initiated.
Thumbnail (small) images will display.

SETUP OPTIONS Button
Sets various camera
settings (see inset below)
using the computer.

How to Check and Change Various Camera Settings
• You can adjust the date, time and owner settings in the “Camera Settings” dialog

using the computer when the camera is connected. You can also check the battery
charge and remaining memory capacity.
1. Click the [SETUP OPTIONS] button.
2. Check or change the settings.

An image of the connected
camera or CF card will display.

Thumbnail

EDIT SLIDESHOW Button
Edits slide shows from the
camera. (➜ p. 34)

UPLOAD Button
Copies images from the computer
to the camera or CF card. (➜ p. 34)

DELETE Button
Deletes the
selected
images.

DOWNLOAD Button
Copies selected images to the computer
from the camera or CF card. (➜ p. 25)

Input a camera owner name here.
(up to 31 characters)

Set the date and time.

Click this button to synchronize
the camera to the computer’s date
and time settings.

Check the battery charge here.

Check the remaining memory
capacity here.
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Loading and Saving Images from the Camera

1. Create a new folder in which to save the images from the camera.
In the Tree View, right-click the [Image Library One] folder, select [New Folder] from
the pop-up menu and input a folder name.

2. Select the new folder in the Tree View.

3. Select the images that you wish to download from the Camera Window
and click the [DOWNLOAD] button.
Click the thumbnail you wish to select or press [Ctrl] and click to select multiple
thumbnails.

The downloaded images will be saved to the computer disk and appear in the
Browser Display Area.

Tree View

Thumbnail
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• You can also download images to the computer by dragging them from the
Camera Window and dropping them on the Browser Display Area or Tree View.

To disconnect the camera, click the close box  at the upper right of the Camera
Window. The Camera Window will close.

Tree View

Browser Display Area
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Printing Images

1. Select the image(s) you wish to print and click the [PRINT] button.

The PhotoRecord printing utility will start and automatically display the selected
image(s) in a page layout.

2. Adjust the print settings if you wish to change the page layout.
Please refer to page 37 or the PhotoRecord Help file for details of the settings.

3. Click the PhotoRecord [PRINT] button.

The “Print” dialog will display.

4. Click the [OK] button to start printing.
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Basic Procedures for Using ZoomBrowser EX
This section provides a simple explanation of the basic procedures for using ZoomBrowser
EX. Please refer to the ZoomBrowser EX Help file for more details.

Displaying Images
Zooming Images In and Out

(a) Double-Clicking the Browser Display Area
Double-click the background frame of the folder in which an image is registered to
zoom it to fill the Browser Display Area.

(b) Selecting a Folder in the Tree View
You can also zoom a folder in or out with its icon selected in the Tree View.

Browser Display Area

Click this button to go back to
a folder one level higher.

Click a higher level folder to zoom out.

Click a lower level folder to zoom in.

Double-click the
background frame
of the folder.
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Zooming a Single Image

Double-click an image in the Browser Display Area to display it in the Image Viewer.

Double-click the target image.
Edit Panel Button

About the Image Viewer Edit Panel
• The edit panel displays when you click Edit Panel button in the Image Viewer.

CROP Button
Drag the cursor to
select the crop area
and click the [CROP]
button to trim
everything outside the
crop area.

SAVE AS Button
Save the image with
a different name and
file format.

UNDO/REDO Buttons
Reverse an action or reimplement it.

COLOR/BRIGHTNESS/CONTRAST Sliders
Slide the tab to adjust the color,
brightness or contrast settings.
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Displaying Images in Chronological Order

Select a folder or some images, click the [View] menu and select [TimeTunnel]. The
selected image(s) will display in a time tunnel. Please refer to the TimeTunnel Help file
for more details on how to operate this function.

Showing Images in a Slide Show

The slide show function displays images saved onto the computer disk one-by-one at
full-screen size as if they were part of a slide show.

1. Click the [View] menu and select [Slide Show Options].

2. Select a play method.
The “Slide Show Options” dialog will display.
Set a play interval and a transition effect and click the [OK] button.

3. Select images from the ZoomBrowser EX Browser Display Area for showing.

4. Click the [View] menu and select [Slide Show].
The selected images will play in order. The slide show will close after the last image
is displayed. If the slide show is set to repeat, press the  on the control panel to
close the slide show.

Drag the tab up or down to go
backward or forward in time.
The time tunnel will advance in
the selected direction.

To quit TimeTunnel and return to
the ZoomBrowser EX window,
click this button.
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About the Print Mark Button
• A print mark can be added to an image by clicking the [Print Mark] button when it

is displayed in a slide show.

• PhotoRecord will automatically start at the end of the slide show and place the
marked images in an auto layout.

• Please refer to page 37 or the PhotoRecord Help file for more details on how to
operate this function.

Print Mark Button
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Organizing Images
Changing the File Location

You can move an image file by dragging and dropping it onto another folder icon.

The [Image Library One] folder is located within the folder in which ZoomBrowser EX
was installed. The Tree View displays files at levels below this folder.

Adding a New Library Folder

Adding a folder to the Tree View allows you to display the images in that folder and its
subfolders in ZoomBrowser EX. Click the [File] menu, select [Add Image Library] and
select the folder. The selected folder will appear in the ZoomBrowser EX Tree View as a
new library.

Refreshing the Contents of a Library

If you have used another program, such as the Windows Explorer utility or Adobe
PhotoDeluxe Home Edition, to move or edit images that are registered with
ZoomBrowser EX, you should select the library, click the [View] menu and select
[Refresh Current Library]. This will update the library.

Drag an image from the Browser Display Area
to another folder in the Tree View.

Browser Display Area

You can also drag
and drop images
within the Browser
Display Area.

Tree View
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Erasing Images

An image cannot be recovered after it is erased. Double-check to make sure you
have the right images before erasing.

Erasing Images Singly

1. Select the target image in the Browser Display Area and click the [DELETE]
button.
A confirmation dialog will display.

2. Check the image to make sure it can be deleted and click [Delete].
The image will be erased.

Erasing Images by Folder

1. Click the background frame of the target folder and the [DELETE] button.
A confirmation dialog will display.

2. Check the images to make sure they can be deleted and click [Delete].
The images and the folder will be erased.

Tree View

Browser
Display Area

Click images
singly to
erase them.

Click on the
folder’s
background
frame to erase
the folder and
all its images.

DELETE Button
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Saving Computer Images to a CF Card in the Camera

1. Open the Camera Window. (➜ pp. 21-23)

2. Click the [UPLOAD] button in the Camera Window.
The “Upload Images from Disk” dialog will display.

3. Select the images from the computer and click the [Open] button.
The “Save to Camera” dialog will display.

4. Select the image size and resizing options and click the [Save to Camera]
button.
The selected image will be saved onto the camera’s CF card.

Editing Camera Slide Shows (PowerShot S10/S20 Only)
This function allows you to edit slide shows played by the camera. To edit slide shows
shown on the computer display, see “Showing Images in a Slide Show.” (➜ p. 30)

1. Open the Camera Window. (➜ pp. 21-23)

2. Click the [EDIT SLIDESHOW] button.
The Edit Slide Show window will display. The camera images will display on the left
side. Images registered in the selected slide show will display on the right side.

Slide Shows 1 to 3 correspond to the numbers of the slide shows that can be
shown with the camera.

3. Drag and drop images from the area on the left to the area on the right
to register them in the slide show.
You can drag images to change their order in the area on the right. This order
corresponds to the replay order.

4. Click the [Save to Camera] button.
The slide show will be saved to the CF card in the camera.

5. Click the [Exit] button on the toolbar.
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Stitching Panoramas Together with PhotoStitch
To Merge Images Registered in ZoomBrowser EX

• You can merge a series of overlapping images into a single, seamless panorama.
• Select the images in the browser area, click the [Edit] menu and select [PhotoStitch].

The PhotoStitch program will start.
• Follow the instructions in the guidance window to merge the images.
• Please refer to the PhotoStitch Help file for more details.

Images Shot in Stitch Assist Mode
• PhotoStitch automatically arranges images shot with the Stitch Assist mode of

Canon digital cameras in the correct order and orientation, making it easy to
merge these images. Stitch Assist mode images display in the Camera Window as
shown below.

Please see the Camera User Guide for instructions for shooting in Stitch Assist mode.

Follow the instructions
to merge the images.

Images shot in Stitch Assist mode have a
green stitch mark. Click the stitch mark to
start PhotoStitch and merge those images.
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Editing and Applying Special Effects to Images

1. Confirm that the Adobe PhotoDeluxe Home Edition program has been
installed.

2. Select an image from the Browser Display Area of ZoomBrowser EX.

3. Click the [Edit] menu and select [Edit Image using Adobe PhotoDeluxe
Home Edition]
Please refer to the Adobe PhotoDeluxe Home Edition Help file and electronic guide
(Getting Started.pdf) for instructions for this program.

4. Edit and apply special effects to the image.
• Once you have finished editing the image, click the [File] menu, select [Export]

and [File Format], and save the image.
• ZoomBrowser EX supports the BMP, FlashPix, JPEG and TIFF file formats.
• If you selected a folder registered in ZoomBrowser EX as the save location, please

return to the ZoomBrowser EX window, click the [View] menu and select [Refresh
Current Library] to update the thumbnail in ZoomBrowser EX.

Sending Images via E-mail
You can send images as attachments to e-mail messages. You can adjust the image size
and quality to reduce the file size for transmission.

1. Select the target image(s) in the Browser Display Area.

2. Click the [File] menu and select [Send Image(s) by E-Mail].

3. Adjust the image size and quality.
The e-mail image creation window will display.

Set the image size and quality and follow the on-screen messages to complete the
procedures.

4. Click the [Finish] button.
When you click the [Finish] button, your e-mail program will start and open a new
message with the image file attached. Input your message, a subject, the recipient’s
address and send the message.

Some e-mail programs or operating systems may not support the auto start
function. In that case, temporarily save the adjusted image file to the desktop or
another easy-to-find folder. Then start your e-mail program, open a new message
and attach the adjusted image file to it.
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Printing Images
• Select a folder or image(s) for printing from the Browser Display Area or Camera

Window and click the [PRINT] button to start the PhotoRecord program.
• You can also click the  button while an image is displayed in a slide show to add a

print mark to it. When the slide show closes, PhotoRecord will start automatically.
• The selected images will automatically display in a page layout.
• Please refer to the PhotoRecord Help file for more details.

PhotoRecord Window

Input titles or captions
anywhere you wish.

Drag the images to
change the layout.

Slide this tab to the left
to shrink the image, right
to expand it.

Click this to display Help.

Click this to display the
“Print” dialog.

Click this to change the
background design or paper
orientation.

Click this to set the default
number of images printed per
page.

Click this to switch
between auto and
manual layout
mode.

Click this to redo the
layouts for all pages.

Click this to stop
importing images.

Click the arrow6
to display a pop-up
menu.

Click these buttons
to select a layout
pattern for each
page.
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Image Resizing Mode Image Rotating Mode

Drag an arrow to
resize the image.

The arrows display
when the mouse is
positioned over
the image.

Click this to change to
rotating mode.

Click this
to display
a pop-up
menu.

Drag an arrow to
rotate the image.

Click this to change
to image resizing
mode.

Click this
to display
a pop-up
menu.

Creating a New Album

The PhotoRecord layouts with titles and captions can be saved as albums. Moreover,
PhotoRecord includes a variety of templates, making it easy to create beautiful albums.

1. To save an album, click the PhotoRecord [File] menu and select [Save As].

2. Input a name and click [Save].

Image Resizing and Rotating Modes

Add a title to the page
Click the arrow6and select
[Edit Title] from the pop-up
menu.

Add a caption to an image
Right-click an image and select [Edit
Caption] from the pop-up menu.

Change the text box format
Right-click a text box and
select [Change Frame] from
the pop-up menu.

Insert text
Click the arrow6and select [Add Text]
from the pop-up menu.

Change the page background
Right-click the page and select
[Change Page Style] from the
pop-up menu.

Change the photo frame
Right-click the image and
select [Change Photo Frame]
from the pop-up menu.
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Precaution when Printing from PhotoRecord from
Windows NT 4.0/Windows 2000
• If the printer name is too long, you may not be able to print from PhotoRecord.

Shorten the name to enable printing.

1. Click the Windows [Start] menu and select [Settings] and [Printers].
2. Click the printer name twice with a slight pause between clicks. Input a new

name that is 31 characters or less. If the printer is a network printer, include the
path name in the 31-character count.
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Backing Up Data
You are recommended to use the following procedures to back up your image data after
you add, delete or change images from ZoomBrowser EX.

1. Click the ZoomBrowser EX [File] menu and select [Backup Database].

2. Input a file name and click [Save].
The current database file will be saved with the specified name.

The database file may become corrupted if a system crash occurs for some reason
when ZoomBrowser EX is being run at the same time as another software program.
You should restore the data in this case. To avoid unintentional loss, you should back
up your image data frequently.

How to Restore the Database File from a Backup File

1. Click the ZoomBrowser EX [File] menu and select [Open Database].

2. Select the appropriate backup file.
Confirm that the backup file has the [.zbd] file extension.

3. Click [Open].
This will restore the database file to the state from which it was backed up.
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Loading Images with TWAIN-Compliant
Application Programs (Adobe PhotoDeluxe,
Adobe Photoshop, etc.)
This section explains how to load images with TWAIN-compliant application programs
using Adobe PhotoDeluxe Home Edition as an example. Please refer to the manual for
each application program for more details.

Installing from the Adobe PhotoDeluxe CD-ROM
For installation instructions, place the Adobe PhotoDeluxe CD-ROM in the drive and click
[ReadMe & Guide] and [Install Guide] in the window that displays.

The serial number shown during installation will be required for the user
registration process.

Starting the Software
USB Interface

1. Connect the camera to the computer’s USB port. (➜ p. 12)

2. Set the camera to the mode for communicating with a computer.
• PowerShot S100 DIGITAL ELPH/DIGITAL IXUS

Slide the mode switch to the  position and press the main switch to turn on
the power.

• PowerShot S10/S20
Turn the mode dial to the  position.

An application selection dialog will display.

3. Select Adobe PhotoDeluxe Home Edition and click [OK].
Adobe PhotoDeluxe Home Edition will start and open the TWAIN driver. Use the
TWAIN driver to load images. (➜ p. 43)
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Serial Interface

1. Attach the camera to the computer with the serial cable. (➜ p. 20)

2. Turn the camera’s mode dial to the  position.

3. Start Adobe PhotoDeluxe Home Edition.

4. Click [Get & Fix Photo] at the upper left of the window.

5. Click [Get Photo] from the icons that display and select [Cameras].

6. Click the [1 Camera] tab.
In the [Camera Models] option, confirm that [Canon Digital Camera RS-232C] is
selected.

7. Click the [Open Camera] button.
The TWAIN driver will start.

8. Click the [Communication Settings] button.

9. Set the port type, port name and baud rate (transfer speed) settings and
click the [OK] button. (➜ p. 43)
For instructions on the communication settings, please refer to page 81.

CF Card Reader or PC Card Slot Interface

1. Place the CF card into the CF card reader or into the PC card adapter and
then into the PC card slot. (➜ p. 19)

2. Start Adobe PhotoDeluxe Home Edition.

3. Click [Get & Fix Photo] at the upper left of the window.

4. Click [Get Photo] from the icons that display and select [Cameras].

5. Click the [1 Camera] tab.
In the [Camera Models] option, confirm that [Canon XXX USB] (XXX will be replaced
by your camera model name) or [Canon Digital Camera RS-232C] is selected. If
several models are listed, select the one that corresponds to your camera.

6. Click the [Open Camera] button.
The TWAIN driver will start. Use it to load images. (➜ p. 43)
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Loading the Camera Images

1. Click the [Camera] button.
To load images directly from a CF card outside the camera, click the [My Computer]
button instead. The images from the camera or CF card will display in the
thumbnail display area.

2. Select the images you wish to download and click the [Acquire] button.
The images will appear in the Adobe PhotoDeluxe Home Edition window.

3. Click the [2 Done] tab in the Adobe PhotoDeluxe Home Edition window.

Guide to the TWAIN Driver Window

Camera Settings Button
Adjust or check camera
settings. (➜ p. 24)

Rotate 90 Degrees Buttons
Rotates the selected image left
or right 90 degrees.

Display Style Buttons

Help Button

Thumbnail Display Area
Image thumbnails (small versions) display
here when the camera is connected.

Main Buttons
These buttons control the main commands,
such as those for loading images and exiting
the TWAIN driver.
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Troubleshooting the USB Driver Installation

Check This First
1. Is the camera connected to the computer correctly? (➜ p. 12)
2. Is the camera power on?

• PowerShot S100 DIGITAL ELPH/DIGITAL IXUS
Slide the mode switch to  and press the main switch to power up the camera.

• PowerShot S10/S20
Turn the mode dial to the  position.

3. Is the battery charge sufficient?
You are recommended to use the AC adapter to power a camera connected to
a computer.

You will not be able to check the USB driver status if there is a problem with any of the
items above.

If the “Add New Hardware Wizard” (in Windows 2000 it is the “New Hardware
Found Wizard”) appears while performing any of the steps above, reinstall the USB
driver using the procedures in the Installing the USB Driver section. (➜ p. 13)

If the three potential problems check out, first uninstall the USB driver with the
procedures below before reinstalling it according to the instructions in the Installing the
USB Driver section. (➜ p. 13)

Uninstalling the USB Driver from Windows 98

Check the USB Driver Status
• Does your camera model name appear in the Windows “Scanners and Cameras

Properties” dialog?
Display the “Scanners and Cameras Properties” dialog with the following steps.
1. Click the [Start] menu and select [Settings] and [Control Panel].
2. Double-click the [Scanners and Cameras] icon.

Check to see if your camera model appears here.
The names of scanners and other devices for
which drivers have already been installed will
show in this window.
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What to Do if Your Camera Model Name Is Not in the
“Scanners and Cameras Properties” Device List or if the
[Scanners and Cameras] Icon Is Not in the Control Panel

1. Double-click the [System Properties] icon in the Control Panel and check
the [Device Manager] tab.

2. Check the [Other devices] or [Imaging Devices] categories for an item
corresponding to your camera model. Delete it with the following
procedures.

1. Select the item corresponding to your camera model and click the [Remove]
button.

2. Click the [OK] button in the confirmation dialog.
3. Click the [OK] button to close the “System Properties” dialog.

Delete all copies if the item corresponding to your camera model appears in more
than one category, such as the [Imaging Devices] and [Other Devices] categories,
or if it is duplicated in the [Other Devices] category.

3. On the Windows desktop, double-click the [My Computer] icon, [C:] icon,
[Windows] folder, and [Inf] folder in succession.

4 4 4
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What to Do if the [Inf] Folder Is Not Visible in the [Windows]
Folder
• Follow the procedures below to set the folder options to the “Show all files” setting.

1. Click the [View] menu and select [Folder Options].
2. Click the [View] tab.
3. In the [Hidden files] category, select [Show all files].
4. Click the [OK] button to close the “Folder Options” dialog.

This will show all the previously hidden files.

4. Find and delete the [Drvdata.bin] and [Drvdx.bin] files.

The [Inf] folder contains numerous files. Ensure that you double-check
the file names before you delete any files. Deleting the wrong file may,
in the worst case scenario, result in the failure of your computer to run
the Windows operating system.

5. Double-click the [Other] folder inside the [Inf] folder.

6. Find and delete the [Canon.IncCanon_DC] file.
Skip this step if this file is not present in the [Other] folder.
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Your camera model name
will appear here.

What to Do if Your Camera Model Appears in the “Scanners
and Cameras Properties” Device List

1. Select the name of your camera model and click the [Remove] button.

2. Click [OK] to close the “Scanners and Cameras Properties” dialog.

3. Delete the [Drvdata.bin], [Drvdx.bin] and [Canon.IncCanon_DC] files
using steps 3 to 6 on pages 45 to 46.

Uninstalling the USB Driver from Windows 2000

Begin by logging onto Windows 2000 as the Administrator and then start removing
the USB driver.

1. Double-click the [Add/Remove Hardware] icon in the control panel.
After the “Add/Remove Hardware Wizard” starts, click the [Next] button.
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2. Select [Uninstall/Unplug Device] and click the [Next] button.

3. Select [Uninstall a Device] and click the [Next] button.

4. Select the name of your camera model from the list that displays and
click the [Next] button

Your camera model
name will appear here.
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5. In the dialog shown below, select [Yes, I want to uninstall this device]
and click the [Next] button.

Click the [Finish] button when the “Add/Remove Hardware Wizard complete”
message displays.

6. On the desktop, double-click the [My Computer] icon, [C:] icon, [Winnt]
folder, and [Inf] folder in succession.

What to Do if the [Inf] Folder Is Not Visible in the [Winnt] Folder
1. Open the [Winnt] folder.
2. Click the [Tools] menu and select [Folder Options].
3. Click the [View] tab.
4. In the [Advanced Settings] category, find the [Hidden Files and Folders]

subcategory and select [Show hidden files and folders].
5. Click the [OK] button to close the “Folder Options” dialog.
This will show all the previously hidden files and folders.

Your camera model
name will appear
here

4 4 4
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7. Look for files starting with [Oem*].
A number such as 0 or 1 will appear in place of the “*”after the “Oem” prefix in
the file name.
For each [Oem*] file there is a companion [Oem*.pnf] file with the same number
following the “Oem” prefix (e.g. the Oem0 and Oem.pnf files form one set of Oem
files).
• Please note that numerous groupings of “Oem” files may be present in the [Inf]

folder. Do not delete the wrong files.

8. Search for the [Oem*] files for Canon digital cameras.
Double-click a file to open it in the Windows Notepad accessory and look for [;***
Canon Digital Camera USB Setup File ****] in the first line. If you find it, note
down the file name and close Notepad.

9. Delete the [Oem*] file and corresponding [Oem*.pnf] file.
Ensure that you have the correct files before deleting them.

The [Inf] folder contains numerous files. Ensure that you double-check
the file names before you delete any files. Deleting the wrong file may,
in the worst case scenario, result in the failure of your computer to run
the Windows operating system.
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Introducing the Software
This section introduces the powerful software programs for the Macintosh platform
contained on the CD-ROMs included with the camera.

Canon Digital Camera Solution Disk

ImageBrowser

To load camera images, start ImageBrowser.

Camera Connection Functions
(Also effective for CF card readers or PC card readers)

• Displays camera images.
• Downloads camera images to the computer.
• Saves computer images to a CF card in the camera.
• Edits slide shows for replay by the camera (PowerShot S10/S20 models only).
• Connecting to a USB port automatically starts ImageBrowser and displays the

camera images.

Image File Management Functions

• Displays, moves, copies or deletes images stored on computer disks.
• Allows simple editing procedures, such as image color adjustments and cropping.
• Displays all the files in a specified folder at once.
• Displays files in chronological order in a window that looks like a time tunnel.
• Replays images from the computer one-by-one at full screen size to simulate a slide

show.

Image Printing Functions

• Prints multiple images on the same page.
• Allows you to freely resize images and change layouts.
• Allows you to place titles or captions anywhere on the page.

Supports PhotoStitch Panoramas

• Allows you to select camera images or images registered with ImageBrowser and
start PhotoStitch from within ImageBrowser to merge a series of images into a
panorama in a few simple steps.
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Supports the Adobe PhotoDeluxe Photo Retouching Program

• Starts this photo-retouching program to edit and apply special effects to your
images. Adobe PhotoDeluxe can be installed from the Adobe PhotoDeluxe CD-ROM.

Adjusting Images for Transmission by E-mail

• Reduces the image size or quality to allow a large image to be sent as an e-mail
attachment.

PhotoStitch
• Automatically arranges images shot in Stitch Assist mode into the correct order

and effortlessly merges them.
• Merges any number of images horizontally or vertically, or in a matrix format.
• Makes images with straight lines appear natural not crooked when merged. (Select

the Wide display format.)
• A 360-degree scene shot in several frames can be merged into a 360-degree

image and saved in the QuickTime VR format, making it appear as if you were
standing in the middle of the image looking about in all directions.

Canon Digital Camera Plug-In Module

The Plug-In Module is the driver utility program that works within Plug-in compliant
application programs, such as Adobe PhotoDeluxe and Photoshop, to load camera
images directly into the application program. The Plug-In Module is started from
within the Plug-in compliant application program. It cannot be used as a stand-alone
software program.

 Adobe PhotoDeluxe CD-ROM

Adobe PhotoDeluxe
• Allows you to edit images and effortlessly create greeting cards, birthday cards and

calendars.
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System Requirements
The following system requirements must be met to install and operate the software.

=Computer Model
Power Macintosh, PowerBook, iMac or iBook

=OS
Mac OS 7.5.3 or higher, QuickTime 2.1 or higher

=CPU
PowerPC

=RAM
20 MB or more of application memory

=Interface
USB: (Power Macintosh NEW G3/G4, PowerBook

G3, iMac, iBook)
• Limited to genuine Apple Computer brand

models with a built-in USB interface
• iMac computers running Mac OS 8.1 require

installation of the “iMac Update 1.0” and
“iMac Firmware Update 1.0”

RS-422: (Printer or modem port for PowerShot S10/S20
models only)

=Free Hard Disk Space
Canon Utilities

ImageBrowser: 20 MB or more
PhotoStitch: 30 MB or more

Canon Digital Camera Plug-In Module: 15 MB or more
Adobe PhotoDeluxe: 70 MB or more

=Display
Minimum: 800 x 600 pixels, 256 colors
Recommended: 1,024 x 768 pixels, Thousands of colors

or more

• A CD-ROM drive is required to install the software.
• Plug-In Module is compatible with Adobe Photoshop 3.0 and higher versions.
• QuickTime 2.5 or higher and the QuickTime VR Extension 2.0.1 or higher are

required to save PhotoStitch output in the QuickTime VR format.
• QuickTime 3 or higher is required to use the color adjustment (➜ p.70) and slide

show functions (➜ p.71) in ImageBrowser.
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Installing/Uninstalling the Software
Installing from the Canon Digital Camera Solution Disk

1. Close any programs that are running.

2. Place the Canon Digital Camera Solution Disk in the CD-ROM drive.

3. Double-click the [CD-ROM] icon and the [Canon Digital Camera Installer]
icon.
The installer panel will display.

4. Click [Software Installation].

5. Select the programs you wish to install and follow the on-screen
instructions to install them.

6. Click the [Quit] button when the installation is complete and restart the
computer if prompted.
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Installing from the Adobe PhotoDeluxe CD-ROM
For installation instructions, please see the electronic guide (Getting Started.pdf)
contained in the [Open Me First!] folder on the Adobe PhotoDeluxe CD-ROM.

The serial number shown during installation will be required for the user
registration process.

Uninstalling the Software
To uninstall a program, drag its folders to the Trash. Be careful, however, not to
accidentally delete any of your images that may be stored in these folders.

For instructions on how to uninstall the Plug-In Module, open the [Canon Utilities] folder
and [Digital Camera Plug-In] folder and read the [ReadMe] file.
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Connecting the Camera to a Computer
Selecting a Connection Method
The following different interfaces and methods can be used to connect the camera to a
computer. Once a connection has been established using one of the methods, you can
start the software and begin to load the camera images (➜ p. 63 or 77).

Use the AC Adapter
• You are recommended to use the AC adapter while the camera is connected to a

computer to conserve the battery charge.

USB Port (➜ p. 59)

The USB interface transfers data more rapidly than the serial interface and can start
the image loading software automatically.

CF Card Reader or PC Card Slot  (➜ p. 61)

If you have a computer equipped with a PC card slot, a CF card reader or a PC card
reader, you can place the camera’s CF card into these devices to establish a direct
connection. You will require a PC card adapter for PC card slots.

PC Card Adapter

CF Card

USB Cable Connector Shapes

Computer EndCamera End

Computer USB Port

The USB port is
marked with
this symbol.
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Serial Port (Printer or Modem Port) (➜ p. 62)

The serial interface is supported by the PowerShot S10 and PowerShot S20 models only.

Serial Cable Connector Shapes

Camera End Computer End

Computer Serial Port

The serial port
is marked with
this symbol.
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Connecting to a USB Port

Requirements for the USB Interface
• The USB interface can only be used to connect the camera to genuine Apple

Computer brand Power Macintosh New G3/G4, PowerBook G3, iMac and iBook
models with built-in USB connectors.

• Connect the USB cable directly to one of the computer’s main USB ports. The
interface may not function correctly if the camera is connected via a USB hub.

• The interface may not function correctly while other USB devices, excluding USB
mice and keyboards, are connected. If this problem arises, detach the camera and
the other devices, and reconnect the camera only.

Important
• Please do not place your computer in the sleep mode while the camera is

connected to its USB port. If the computer goes into sleep mode while the camera
is connected to a USB port, do NOT disconnect the USB cable from the camera or
computer. Try to revive the computer. If the USB cable is detached in sleep mode,
some computers may not return to active mode correctly. For instructions
regarding the sleep mode, please consult the manual accompanying your
computer and operating software.
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1. Attach the supplied USB cable to a USB port directly on the computer
and to the DIGITAL terminal on the camera as shown below.
• There is no need to turn the camera or computer power off when attaching or

detaching the USB cables.
• Please consult your computer’s manual for the location of the USB ports.

Precaution for Unplugging Cables
from the DIGITAL Terminal
• Always press the [PUSH] button on the

connector to detach the cable from the
camera’s DIGITAL terminal.

USB Port

DIGITAL Terminal
1. Open the DIGITAL terminal cover

by slipping a fingernail under the
top edge and pulling down.

USB Connector

USB Connector

2. Insert the connector so that the4 marks on
the connector and camera align.

PUSH Button
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Connecting via a CF Card Reader or PC Card Slot
To load images directly from a CF card to a computer, eject the card from the camera,
place it in a separately sold PC card adapter (PCMCIA card adapter) and insert the
assembly into the PC card slot.

The adapter is not required if your computer is equipped with a CF card reader. Place the
CF card directly into the reader.

1. Place the CF card in the PC card adapter.

2. Insert the loaded PC card adapter into the computer’s slot or PC card
reader.
The requirements for the power being on or off when the PC card adapter is
inserted differ according to the product. Please consult the manuals accompanying
your equipment.

Insert the Adapter in the Slot.

Place the CF Card in the Adapter.



62

Connecting to a Serial Port (Printer or Modem Port)
The serial port interface is only supported by the PowerShot S10 and PowerShot S20
models.

1. Shut down the computer and turn the camera power off.

2. Attach the supplied serial cable to a serial port on the computer and to
the camera’s DIGITAL terminal as shown below.
• Please consult your computer’s manual for the location of the serial port.

3. Turn on the computer.

About AppleTalk
• When connected via the serial interface using AppleTalk, open the Apple menu ,

select [Chooser] and turn AppleTalk to [Inactive].

PUSH Button

Precaution for Unplugging Cables
from the DIGITAL Terminal
• Always press the [PUSH] button on the

connector to detach the cable from the
camera’s DIGITAL terminal.

Modem Port

DIGITAL Terminal
1. Open the DIGITAL terminal cover

by slipping a fingernail under the
top edge and pulling down.

Serial Connector

Serial Connector

2. Insert the connector so that the4 marks on
the connector and camera align.

Printer Port
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From Loading to Printing
This section provides a simple explanation of the procedures for using ImageBrowser to
load and print images. Please refer to the ImageBrowser Help file for more details.

What to Do if a Warning Dialog Displays
• If approximately five minutes pass without a camera function being accessed when

the camera is connected via the USB interface, a message on the computer display
will ask if you wish to remain connected. If you do not access a function, the
camera will close the connection after an additional minute passes. Use the
procedure below to reconnect.
• PowerShot S100 DIGITAL ELPH/DIGITAL IXUS

Press the camera’s main switch.
• PowerShot S10/S20

Press the camera’s shutter button. (The dialog will not appear and the camera
will not close the connection if the camera is being powered by the AC adapter.)

Starting ImageBrowser
USB Interface

1. Attach the camera to the computer with the USB cable. (➜ p. 60)

2. Set the camera to the mode for communicating with a computer.
• PowerShot S100 DIGITAL ELPH/DIGITAL IXUS

Slide the mode switch to the  position and press the main switch to turn on
the power.

• PowerShot S10/S20
Turn the mode dial to the  position.

ImageBrowser will automatically start and display the “communication settings”
dialog.

3. Confirm that [USB Port] and your camera model are selected and click
the [Set] button.
The images from the camera will display as small thumbnail images in the
ImageBrowser Camera Window. (➜ p. 66)
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How to Set ImageBrowser to Not Start Automatically
1. Open the Apple menu  and select [Control Panels] and [Canon USB Camera].

The “Settings for USB Connection” dialog will display.
2. Click the [The application program below will start.] option to clear the check mark.
3. Click the close box at the upper left to close the dialog. ImageBrowser will cease to

start automatically thereafter.

CF Card Reader or PC Card Slot Interface

1. Place the CF card into the CF card reader or into the PC card adapter and
then into the PC card slot. (➜ p. 61)

2. Start ImageBrowser.
Double-click the [Canon ImageBrowser] icon on the desktop to start the program.

If the [Canon ImageBrowser] icon does not appear on the desktop, open the
[Canon Utilities] folder and [ImageBrowser] folder and double-click the
[ImageBrowser] icon.

3. Double-click the [DCIM] folder in the Explorer View Section.
The images from the CF card will display in ImageBrowser Camera Window as small
thumbnail images. (➜ p. 66)

Clear the check mark to stop
ImageBrowser from
automatically starting.

Click here to close the dialog.

Canon ImageBrowser Icon

Explorer View Section
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Serial Interface

1. Attach the camera to the computer with the serial cable. (➜ p. 62)

2. Turn the camera’s mode dial to the  position.

3. Start ImageBrowser.
Double-click the [Canon ImageBrowser] icon on the desktop to start the program.

If the [Canon ImageBrowser] icon does not appear on the desktop, open the
[Canon Utilities] folder and [ImageBrowser] folder and double-click the
[ImageBrowser] icon.

4. Click the [CAMERA] button.
The camera’s images will display in ImageBrowser Camera Window as small
thumbnail images. (➜ p. 66)

Canon ImageBrowser Icon
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The ImageBrowser Camera Window
The Camera Window will open when a connection to a camera or CF card is initiated.
Thumbnail (small) images will display.

How to Check and Change Various Camera Settings
• You can adjust the date, time and owner settings in the “Camera Settings” dialog

using the computer when the camera is connected. You can also check the battery
charge and remaining memory capacity.
1. Click the [SETUP OPTIONS] button.
2. Check or change the settings.

Input a camera owner name here.
(up to 31 characters)

Click this button to synchronize
with the computer’s date and time
settings.

Set the date and time.

Check the battery charge here.

Check the remaining memory
capacity here.

SETUP OPTIONS Button
Sets various camera
settings (see inset below)
using the computer.

An image of the connected
camera or CF card will display.

Thumbnail

EDIT SLIDESHOW Button
Edits slide shows from the
camera. (➜ p. 74)

UPLOAD Button
Copies images from the computer
to the camera or CF card. (➜ p. 74)

DELETE Button
Deletes the
selected images.

DOWNLOAD Button
Copies selected images to the computer
from the camera or CF card. (➜ p. 67)
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Loading and Saving Images from the Camera

1. Select [Macintosh HD] in the Explorer View Section.

2. Create a new folder in which to save the images from the camera.
Open the [File] menu and select [New Folder]. A folder with the name “Untitled”
will be created. Click the folder and change the name as you wish.

3. Select the new folder in the Explorer View Section.

Explorer View Section



68

4. Select the images that you wish to download from the Camera Window
and click the [DOWNLOAD] button.
Click the thumbnail you wish to select or press [Shift] and click to select multiple
thumbnails.

The downloaded images will be saved to the computer disk and appear in the
Browser Window.
• You can also download images to the computer by dragging them from the

Camera Window and dropping them on the Browser Window or Explorer View
Section.

To disconnect the camera, click the close box  at the upper left of the Camera
Window. The Camera Window will close.

Thumbnail

Browser Window

Explorer View Section
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Printing Images

1. Select the image(s) you wish to print and click the [PRINT] button.
The Print window will display with the images arranged in an auto layout.

2. Adjust the print settings if you wish to change the page layout.

3. Click the [PRINT] button in the Print window.

Print Window
Please see the ImageBrowser Help file for more details on the Print window.

Edit the Page Title
Open the [Edit]
menu and select
[Edit Header].

Change the Layout
Drag the images to
change the layout.

Add Text
Open the [Edit]
menu and select
[Add Text].

This button
displays the Print
dialog.

This changes the default
number of images
printed per page.

Click this to rotate
the selected
image.

Click this to reset
the image layout
to the initial
setting.

Change the Image Size
Drag the border to resize
the image.

Add a caption to an image
Click an image and select
[Edit Caption] from the [Edit]
menu.
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Basic Procedures for Using ImageBrowser
This section provides a simple explanation of the basic procedures for using
ImageBrowser. Please refer to the ImageBrowser Help file for more details.

Displaying Images
Zooming Images In and Out

You can zoom images in and out by clicking the  (REDUCE) or  (ENLARGE)
button.

Zooming a Single Image

Double-click an image in the Browser Window to display it in the Viewer Window.

About the Viewer Window Edit Panel

Double-click the target image.

Edit Panel

ADJUST COLOR Button
Color, brightness and contrast can be
adjusted in the “Adjust Color” dialog.

CROP Button
Drag the mouse cursor to select a crop
area and click the [CROP] button to trim
unwanted portions of images.

SAVE Button
Saves the edited
image as a new
file.
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Displaying Images in Chronological Order

Select a folder, choose the [Display] menu and select [Switch to TimeTunnel]. All of the
images in the selected folder will display in a time tunnel. To return to the Browser
Window, choose the [Display] menu and select [Switch to Browser View].

Showing Images in a Slide Show

The slide show function displays images saved onto the computer disk one-by-one at
full-screen size as if they were part of a slide show.

1. Click the [Display] menu and select [Slide Show Options].

2. Select a play method.
The “Slide Show Options” dialog will display. Set a play interval and a transition
effect and click the [OK] button.

3. Select images from the ImageBrowser Browser Window for showing.

4. Click the [Display] menu and select [Slide Show].
The selected images will play in order. The slide show will close after the last image
is displayed. If the slide show is set to repeat, press the [Esc] key to close the slide
show.

Drag the tab up or
down to go
backward or forward
in time.
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Organizing Images
Changing the File Location

You can move an image file or folder by dragging and dropping it in another location.

(a) Drag and drop images from the Browser Window to another
folder in the Explorer View Section.

(b) Drag and Drop a Folder within the Explorer View Section

Refreshing the Contents of the Browser Window

If you have used the Macintosh Finder or another program to move or edit images
that are registered with ImageBrowser, you should click the [Display] menu and select
[Refresh].

Browser Window

The file or folder will
move to the item
outlined in blue.

Explorer View Section
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Erasing Images
Erasing Images Singly

Select the target image in the Browser Widnow and click the [SEND TO TRASH]
button.

Erasing Images by Folder

1. Click the target folder in the Explorer View Section.
The images in the folder will display in the Browser Window.

2. Click the [SEND TO TRASH] button.

The deleted image files and folders are moved to the Trash folder on the desktop.

To restore the deleted items, open the desktop Trash folder and drag and drop the
target files or folders to their original locations.

Browser Window
Click the image in the Browser
Window to delete a single image.

Explorer View Section
Click on a folder in the
Explorer View Section to
delete all its images in
one step.

SEND TO TRASH Button
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Saving Computer Images to a CF Card in the Camera

1. Open the Camera Window. (➜ pp. 63-65)

2. Click the [UPLOAD] button in the Camera Window.
The “Select Images to Add” dialog will display.

3. Select the images from the computer and click the [Open] button.
The “Save to Camera” dialog will display.

4. Select image size and resizing options and click the [Save to Camera]
button.
The selected image will be saved onto the camera’s CF card.

Editing Camera Slide Shows (PowerShot S10/S20 Only)
This function allows you to edit slide shows played by the camera. To edit slide shows
shown on the computer display, see “Showing Images in a Slide Show.” (➜ p. 71)

1. Open the Camera Window. (➜ p. 63-65)

2. Click the [EDIT SLIDESHOW] button.
The SlideShowMaker window will display. The camera images will display on the
left side. Images registered in the selected slide show will display on the right side.

Slide Shows 1 to 3 correspond to the numbers of the slide shows that can be
shown with the camera.

3. Drag and drop images from the area on the left to the area on the right
to register them in the slide show.
You can drag images to change their order in the area on the right. This order
corresponds to the replay order.

4. Click the [Save to Camera] button.
The slide show will be saved to the CF card in the camera.

5. Click the [Quit] button on the toolbar.
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Stitching Panoramas Together with PhotoStitch
To Merge Images Registered in ImageBrowser

• You can merge a series of overlapping images into a single, seamless panorama.
• Select the images in the browser area, choose the [Edit] menu and select

[PhotoStitch]. The PhotoStitch program will start.
• Follow the instructions in the guidance window to merge the images.
• Please refer to the PhotoStitch Help file for more details.

Images Shot in Stitch Assist Mode
• PhotoStitch automatically arranges images shot with the Stitch Assist mode of

Canon digital cameras in the correct order and orientation, making it easy to
merge these images. Stitch Assist mode images display in the Camera Window as
shown below.

Please see the Camera User Guide for instructions for shooting in Stitch Assist mode.

Follow the instructions
to merge the images.

Images shot in Stitch Assist mode have a
green stitch mark. Click the stitch mark to
start PhotoStitch and merge those images.
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Editing and Applying Special Effects to Images

1. Confirm that the Adobe PhotoDeluxe program has been installed.

2. Select an image from the Browser Window of ImageBrowser.

3. Click the [Edit] menu and select [Adobe PhotoDeluxe].
Please refer to the Adobe PhotoDeluxe Help file and electronic guide (Getting
Started.pdf) for instructions for this program.

4. Edit and apply special effects to the image.
• Once you have finished editing the image, click the [File] menu, select [Send to]

and [File Format] and save the image.
• ImageBrowser supports the BMP, JPEG, PICT and TIFF file formats.
• Click the [Display] menu and select [Refresh] to update the folder data.

Adding Sound Annotations to Images
If your computer has a microphone, you can attach a sound annotation to an image by
clicking it in the Browser Window, choosing the [Sound] menu and selecting [Record].

Adjusting Images for Transmission by E-mail
You can adjust the image size and quality to reduce the file size of an image for
transmission as an e-mail attachment.

1. Select the target image(s) in the Browser Window.

2. Click the [File] menu and select [Create Image for Email].

3. Adjust the image size and quality.
The e-mail image creation window will display.
Set the image size and quality and follow the on-screen messages to complete the
procedures.

4. Click the [Finish] button.
When you click the [Finish] button, the image will appear in the [Email Images]
folder and your e-mail program will start.

5. Create a new message.
Drag and drop the image from the [Email Images] folder into the message. Input
your message, a subject, the recipient’s address and send the message.
• Some e-mail programs will not start automatically. Start them manually if required.
• The image file to be sent via e-mail will be saved to the [ImageBrowser.mail]

folder in the [ImageBrowser] folder. If you cannot drag and drop the file from
the [Email Images] folder, look for it in the [ImageBrowser.mail] folder and
attach it to your message.
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Loading Images with Plug-in Compliant
Application Programs (Adobe PhotoDeluxe,
Adobe Photoshop, etc.)
This section explains how to load images with Plug-in compliant application programs
using Adobe PhotoDeluxe as an example. Please refer to the manual for each application
program for more details.

Installing from the Adobe PhotoDeluxe CD-ROM
For installation instructions, please see the electronic guide (Getting Started.pdf)
contained in the [Open Me First!] folder on the Adobe PhotoDeluxe CD-ROM.

The serial number shown during installation will be required for the user
registration process.

Copying the Plug-In Module to the [Plug-ins] Folder

1. Open the [Canon Utilities] and [Digital Camera Plug-In] folders.

2. Copy the [Canon Digital Camera] file to the [Acquire/Export] folder.
Open the [Adobe PhotoDeluxe], [Plug-ins] and [Acquire/Export] folders and copy
the [Canon Digital Camera] file into the [Acquire/Export] folder.

Starting the Software
USB Interface

1. Connect the camera to the computer’s USB port. (➜ p. 60)

2. Set the camera to the mode for communicating with a computer.
• PowerShot S100 DIGITAL ELPH/DIGITAL IXUS

Slide the mode switch to the  position and press the main switch to turn on
the power.

• PowerShot S10/S20
Turn the mode dial to the  position.

Although ImageBrowser will start automatically, you should close it in this case.
• See page 64 for instructions on how to set ImageBrowser so that it doesn’t start

automatically.

3. Start Adobe PhotoDeluxe. (➜ p. 79)
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What to Do if the “ImageBrowser not found” Dialog Appears
If you install only the Canon Digital Camera Plug-In Module without ImageBrowser,
the “ImageBrowser not found” dialog may display. If this happens, use the following
procedures to prevent ImageBrowser from attempting to start automatically.

1. Click the [OK] button on the “ImageBrowser not found” dialog.
2. In the “Settings for USB connection” dialog, click the [The application program

below will start.] option to clear the check mark.
3. Close the “Settings for USB connection” dialog.
This will prevent the “ImageBrowser
not found” dialog from appearing
again when the camera is
connected.
• The “Settings for USB connection”

dialog can be opened by choosing
the Apple menu  and selecting
[Control Panels] and [Canon USB
Camera]. (➜ p. 64)

CF Card Reader or PC Card Slot Interface

1. Place the CF card into the CF card reader or into the PC card adapter and
then into the PC card slot. (➜ p. 61)

2. Start Adobe PhotoDeluxe. (➜ p. 79)

Serial Interface

About AppleTalk
When connected to the printer or modem port via AppleTalk, choose the Apple
menu , select [Chooser] and set AppleTalk to [Inactive].

1. Connect the camera to the computer with the serial cable. (➜ p. 62)

2. Turn the camera’s mode dial to the  position.

3. Start Adobe PhotoDeluxe. (➜ p. 79)

Click here to close the dialog.

Click here to clear the check mark.
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Starting the Plug-In Module

1. Click the [Get Photo] button at the upper left of the window.

2. Click [Get Photo] from the tab that displays and select [Cameras].

3. In the “Select Input Source” dialog, select [Canon Didital Camera] and
click the [OK] button.
These three steps are not required after the first time.

4. Click the [Camera] icon.
The Plug-In Module will start.

5. Click the  icon and set the communication settings.
This step is only required for connections via the USB or serial ports.
• USB Interface

Confirm that [USB Port] and your camera model have been selected and click
the [Set] button.

• Serial Interface
Select the port and baud rate settings and click the [Set] button.
For instructions on the communication settings, please refer to page 82.

Loading Images from the Camera

1. Click the [Camera] button.
Click the [Computer] button if you are loading images directly from a CF card.
The images from the camera or CF card will display in the thumbnail display area.

2. Select an image and click the [Acquire] button.

3. In the [Untitled] column of Adobe PhotoDeluxe, input a file name and
click the [Save] button.
The thumbnails will appear in the My Photos window at the lower right of the
Adobe PhotoDeluxe window.

4. Click the [Quit] button.
You can display an image at a larger size by double-clicking it in the My Photos
window.
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Settings Buttons
Use these buttons
to set the
communications
and preference
settings for the
camera.(➜ p. 66)

Display Style Button

Rotate 90 Degrees Buttons
Rotates selected image left or right
90 degrees.

Image Information Button

Thumbnail Display Area
Thumbnail (small) images
display here when the camera
is connected.

Main Buttons
These buttons control
the main commands
for actions such as
loading images and
quitting Plug-In
Module.

Guide to the Plug-In Module Window
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Troubleshooting the Computer Connection

Double-Check:
1. Is the cable between the camera and computer correctly attached?

Windows Platform (➜ p. 9)
Macintosh Platform (➜ p. 57)

2. Has the camera been set to the mode for communicating with a computer?
• PowerShot S100 DIGITAL ELPH/DIGITAL IXUS

Slide the mode switch to the  position and press the main switch to turn
on the power.

• PowerShot S10/S20
Turn the mode dial to the  position.

3. Is the battery charge sufficient?
You are recommended to use the AC adapter when connecting to a computer.

If the above conditions are met, check the following items.

Windows Platform
• Have you tried switching the cable to a different port?

If there is more than one port, try switching the cable to another port.

• Are the communication settings appropriate?
If the settings for the port to which the camera is connected are incorrect, the
“Communication Settings” dialog will display.

Select [USB] or [RS-232C].

Select the port to which the
interface cable is connected.

If you are unsure to which serial
port you are connected, click the
[Auto Detect] button.

Normally you should not need to
change this setting, but set it to a
lower speed if you try everything
else and still cannot load images.
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Macintosh Platform
• Have you tried switching the cable to a different port?

If there is more than one port, try switching the cable to another port.

• Are the communication settings appropriate?
If the settings for the port to which the camera is connected are incorrect, the
“Communication Settings” dialog will display.

• If you are using LocalTalk, has AppleTalk been set to Off?
When connected to a serial port (printer or modem port) via AppleTalk, choose the
Apple menu , select [Chooser] and set AppleTalk to the [Inactive] option.

If the problem persists after implementing the suggestions above, please contact a
Canon Customer Support Help Desk.

Select the port to which the interface
cable is connected.

Normally you should not need to
change this setting, but set it to a
lower speed if you try everything
else and still cannot load images.
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Customer Support
Canon Customer Support

Canon Inc.
30-2 Shimomaruko 3-chome, Ohta-ku, Tokyo
146-8501, Japan

NORTH AMERICA
Canon U.S.A., Inc.
Canon Customer Care Center
Phone (US): 1-800-828-4040
(Available Mon. - Fri., 9 AM to 8 PM Eastern Time)

Canon Canada Inc.
Phone (Canada): 1-800-OK-CANON (1-800-652-2666)
(24 hours/day, 7 days/week)

EUROPE
Europe, Africa & Middle East

Canon Europa N.V.
PO Box 2262, 1180 EG Amstelveen, The Netherlands

Canon (UK) Ltd.
Helpdesk
Tel No.: 08705 143 723 (Calls may be recorded.)
Fax No.: 08705 143 340     BBS No.: 08705 143 350

Canon France S.A.
Hotline : 01.41.99.70.70
Tél :  01.41.99.77.77    Télécopie : 01.41.99.79.51

Canon Photo Vidéo France S.A.
Hotline : 01.49.04.01.00    Télécopie : 01.49.04.01.01

Canon Deutschland GmbH
Canon-Hotline-Service
Customer-Support: (02151) 349-555
Telefax: (02151) 349-588
Info-Desk Tel: (02151) 349-566
Info-Desk Fax : (02151) 349-599
Mailbox : (02151) 349-577

Canon Euro-Photo GmbH
Customer-Support: (02154) 495-610
Info-Desk: (02154) 495-444     Fax: (02154) 495-333

Canon Italia S.p.A.
Pronto Canon : 02 8249 2000     BBS : 02 8249 2099

Canon Belgium N.V. / S.A.
Helpdesk: 0900-10627
Tel.: (02) 722.04.11     Fax: (02) 721.32.74

Canon Luxembourg S.A.
Tel.: (352) 48 47 961     Fax: (352) 48 47 96232

Canon Nederland N.V.
Helpdesk: 023 - 5 681 681
Tel.: 023 - 5 670 123     Fax: 023 - 5 670 124

Canon Danmark A/S
Hotline: 44 88 26 66

Canon España S.A.
Help Desk: 906 301 255
Tel: (91) 538 45 00     Fax: (91) 411 41 76
E-mail: helpdesk@btlink.net

Canon Norge as
Tlf. 22 62 93 21     Faks: 22 62 06 15
E-mail: helpdesk@canon.no

Finland
Canon OY
Puhelin: 010 54420     Fax: 010 544 4571
Help Desk: 0600 0 22606 (14,80 mk/min+pvm)
Help Desk: 0600 0 22666 (enint. 40mk/puhelu+pvm)
Sähköposti: helpdesk@canon.fi

Canon (Schweiz) AG
Tel. 01-835-6161,  Fax 01-835-6860
Hotline 0900 57 55 20

Canon Svenska AB
Stensätravägen 13, S-127 88, Skärholmen, Sweden

Austria
Canon GmbH
Zetschegasse 11, 1232 Wien, Austria
Tel: 01 680 88-0     Fax: 01 680 88-222

OCEANIA
Canon Australia Pty. Ltd.
Info-Line: (02) 9805 2864

Canon New Zealand Ltd.
Info-Line: 0900-522666

ASIA
Canon Singapore Pte. Ltd.
79 Anson Road, #09-01 / 06, Singapore 079906
Phone: (65) 532 4400     Fax: (65) 221 7577

Canon Hongkong Co., Ltd.
9/F, The Hong Kong Club Building, 3A Chater Road,
Central, Hong Kong
Phone: 852-2739-0802     Fax: 852-2369-7701

Canon Marketing Services
No.1 Jalan Kilang Timor, #09-00, Pacific Tech Centre,
Singapore 159303
Phone: (65) 799 8888     Fax: (65) 273 3317

Canon Marketing (Malaysia) Sdn. Bhd.
Wisma General Lumber, Block D, Peremba Square,
Saujana Resort, Section U2, 40150,
Shah Alam, Selangor Darul Ehsan, Malaysia
Phone: (60) 3 744 6000, (60) 3 745 0055
Fax: (60) 3 745 0505

Canon Marketing (Thailand) Co., Ltd.
10th Floor, Bangkok City Tower,
179/34-45 South Sathorn Road,
Bangkok 10120, Thailand
Phone: (662) 344 9999      Fax: (662) 344 9910

Canon Marketing (Hongkong) Co., Ltd.
10/F, Mirror Tower, 61 Mody Road, Tsimshatsui East
Kowloon HongKong
Phone: 852-2170-2828      Fax: 852-2723-9684
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Adobe Customer Support
To view information on the support options available from Adobe:

Windows
1. Use the Microsoft windows Explorer to open the [Support] folder in the PhotoDeluxe Home

Edition CD-ROM.
2. Double-click the folder that corresponds to your geographic location. Inside, you will find a

file that contains more detailed support information for your location.

Macintosh computer
1. Open the [Support] folder in the PhotoDeluxe CD-ROM.
2. Double-click the folder that corresponds to your geographic location. Inside, you will find a

file that contains more detailed support information for your location.


